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1. Related Manuals 
 

The table below lists the manuals related to this document.  

To ensure system safety, make sure to always read and heed the information provided in all 

Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device which is used in the system.  

 

Cat. No. Model Manual name 

W500 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W497 CJ1W-DRM21 CJ-series DeviceNetTM Units Operation Manual for 

NJ-series CPU Unit 

W267 - DeviceNetTM Operation Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 

W464 - CX-Integrator Ver.2. Operation Manual 

3HAC021313-001 IRC5 Product Manual Robot Controller IRC5 

3HAC020676-001 IRC5 Application Manual DeviceNet 

 

 

2. Terms and Definitions 
 

Term Explanation and Definition 

Master/Slave A master is a unit that controls the DeviceNet communications.  

A master sends output data to multiple slaves and receives input data 

from the slaves.  

Slaves receive output data that are sent from the master, and send input 

data to the master.  

At least one master is required for a DeviceNet system.  

EDS file An EDS file is a file that contains the I/O points of DeviceNet slave units 

and the parameters that can be set via DeviceNet.  

Node address 

(MAC ID) 

A node address is an address to identify a unit connected to DeviceNet. 

With DeviceNet, a MAC (Media Access Control) ID is used as a node 

address. Thus, a node address is a MAC ID.  

Scan list A scan list is used to register slaves with which a master communicates 

in DeviceNet remote I/O communications. A master communicates with 

the slaves based on the scan list settings.  
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3. Remarks 
 

(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 

circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, always read and heed the information provided in all Safety 

Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 

conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 

document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of June 2013. It is subject to 

change without notice for improvement.  

 
The following notation is used in this document.  

 

Indicates a potentially hazardous situation which, if not avoided, 
will result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or in property damage. 

 
 

Precautions for Safe Use 

Precautions on what to do and what not to do to ensure safe usage of the product.  

 

Precautions for Correct Use  

Precautions on what to do and what not to do to ensure proper operation and performance. 

 

Additional Information  
Additional information to read as required.  

This information is provided to increase understanding or make operation easier.  

 
Symbol 
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4. Overview 
 

This document describes the procedure for connecting the Robot Controller (IRC5) of ABB Ltd. 

(hereinafter referred to as ABB) to the NJ-series Automation Controller + DeviceNet Unit of 

OMRON Corporation (hereinafter referred to as OMRON), and provides the procedure for 

checking their connection. 

It describes the procedure for performing DeviceNet remote I/O communications using the 

DeviceNet settings of the project file prepared beforehand (hereinafter referred to as the 

"procedure for using the configuration files"). 

Section 9 A-1 and Section 10 A-2 describe the procedures for setting parameters with 

software without using files (hereinafter referred to as the "procedure for setting parameters 

from the beginning". 

 

To follow the "procedure for using configuration files", obtain the latest "Sysmac Studio project 

file" and "CX-Integrator project file" (they are referred to as "configuration files") from OMRON 

in advance. 

 
Name File name Version 

Sysmac Studio project file 
(extension: smc) 

ABB_IRC5_DN_EV100.smc Ver.1.00 

CX-Integrator project file 
(extension: cin) 

ABB_IRC5_DN_EV100.cin Ver.1.00 
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 

The applicable devices are as follows: 

 

Manufacturer Name Model 

OMRON NJ-series CPU Unit 
NJ501-[][][][] 

NJ301-[][][][] 

OMRON DeviceNet Unit (master) CJ1W-DRM21 

ABB Robot Controller IRC5 

ABB Manipulator IRB series 

 

Precautions for Correct Use  

As applicable devices above, the devices with the models and versions listed in Section 5.2. 

are actually used in this document to describe the procedure for connecting devices and 

checking the connection.  

You cannot use devices with versions lower than the versions listed in Section 5.2.  

To use the above devices with versions not listed in Section 5.2 or versions higher than those 

listed in Section 5.2, check the differences in the specifications by referring to the manuals 

before operating the devices.  

 

Additional Information  
This document describes the procedure to establish the network connection. Except for the 

connection procedure, it does not provide information on operation, installation or wiring 

method. It also does not describe the functionality or operation of the devices. Refer to the 

manuals or contact the device manufacturer.  

(ABB Ltd. http://www.abb.com/) 

This URL is the latest address at the time of this document creation. Contact each device 

manufacturer for the latest information.  
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5.2. Device Configuration 

The hardware components to reproduce the connection procedure of this document are as 

follows:  

 

 

 

 

 

 

 

 

 

 

Manufacturer Name Model Version 
OMRON DeviceNet Unit (master) CJ1W-DRM21 Ver.1.1 

OMRON CPU Unit NJ501-1500 Ver.1.05 
OMRON Power Supply Unit NJ-PA3001  
OMRON DeviceNet cable DCA1-5C10  
OMRON T-branch Tap DCN1-1C  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.06 

OMRON CX-Integrator (Included in Sysmac Studio.) Ver.2.57 

OMRON Sysmac Studio project file ABB_IRC5_DN_EV100.smc Ver.1.00 

OMRON CX-Integrator project file ABB_IRC5_DN_EV100.cin Ver.1.00 

- Personal computer  
(OS: Windows7) 

-  

- USB cable 
(USB 2.0 type B connector)

-  

- Communications power 
supply 

-  

ABB Robot Controller IRC5 M2004 RW5.14-03.0
1.3071. 

ABB Manipulator IRB 140 M2004  
ABB FlexPendant -  
ABB EDS file IRC5_Slave.eds Ver.1.1 

 

Precautions for Correct Use  
Prepare the corresponding EDS file beforehand.  
To obtain, contact ABB Ltd.  

 

Precautions for Correct Use  

When there is an icon file specific to the device, the icon file and the EDS file must be stored 

in the same folder.  

 

DeviceNet cable 

IRC5 M2004 NJ501-1500+ 
CJ1W-DRM21

T-branch Tap (DCN1-1C) 

 

Personal computer  
(Sysmac Studio installed, 
OS:Windows 7) 
 

USB cable IRB 140 M2004 

FlexPendant 

Communications 
power supply 
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Precautions for Correct Use  

Prepare the latest "Sysmac Studio project file" and "CX-Integrator project file" from OMRON 

in advance. 

(To obtain the files, contact your OMRON representative.) 

 

Precautions for Correct Use  

Update the Sysmac Studio to the version specified in this section or higher version using the 

auto update function.  

If a version not specified in this section is used, the procedures described in Section 7 and 

subsequent sections may not be applicable. In that case, use the equivalent procedures 

described in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

Additional Information  
For information on the DeviceNet cable and network wiring, refer to Chapter 2 Network 

Configuration and Wiring of the DeviceNet Operation Manual (Cat. No. W267).  

Connect a terminating resistor to each end of the trunk line of DeviceNet.  

 

Additional Information  
The system configuration in this document uses USB for the connection to the Controller. For 

information on how to install a USB driver, refer to A-1 Driver Installation for Direct USB Cable 

Connection of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  
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6. DeviceNet Settings 
 

This section describes the specifications such as communication parameters and remote I/O 

communications that are defined in this document.  

Hereinafter, the Robot Controller is referred to as the "destination device" in some 

descriptions. 

 

6.1. Setting the DeviceNet Communications Parameters  

The communications parameters required to connect the Controller and the destination device 

via DeviceNet are given below. 

 

 Controller (DeviceNet Unit) Robot Controller 

Unit number 0 - 

Bus type - DeviceNet1 

Unit Name - tmp0 

Node address (MAC ID) 63 0 

Baud rate (bps) 500kbps 500kbps 

 

6.2. Allocation for Remote I/O Communications 

The remote I/O communications data of the destination device are allocated to the global 

variables of the Controller. The allocation for the remote I/O communications data is called a 

scan list. The relationship between the device data and the global variables is shown below.  

The following global variables are defined in the "Configuration file". 

 

■Output area (Controller → Robot Controller) 

Destination device data Memory used for 

CJ-series Units 

Global variable name Data type 

Digital Input 00 to 63 %3200 to %3203 DN00_InputData_OUT BOOL[64]

 

■Input area (Controller ← Robot Controller) 

Destination device data Memory used for 

CJ-series Units 

Global variable Data type 

Digital Outputs 00 to 63 %3300 to %3303 DN00_OutputData_IN BOOL[64]

 

In this document, only bits 0 to 3 of the input and output areas are allocated. 

■Details on output area 
63 to 4 3 2 1 0 

DN00_InputData_OUT[64]
Not allocated di4 di3 di2 di1 

 

■Details on input area 
63 to 4 3 2 1 0 

DN00_OutputData_IN[64] 
Not allocated do4 do3 do2 do1 
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Additional Information  
When the DeviceNet Unit is used with a Controller, slave data are allocated to the memory 

used for CJ-series Units. With programs, specify variable names for the memory used for 

CJ-series Units. 

With Sysmac Studio, add the prefix "%" to each address to indicate the memory used for 

CJ-series Units.  

 

Additional Information  
With the Sysmac Studio, two methods can be used to specify an array for a data type. After 

entering, (1) is converted to (2) and the data type is always displayed as (2).  

(1)WORD[3] / (2) ARRAY[0..2] OF WORD 

In this document, the data type is simplified by displaying WORD[3].  

(The example above means a WORD data type with three array elements.) 
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Personal computer 

Destination 

device 

Controller 

 

7. DeviceNet Connection Procedure 
 

This section describes the procedure for connecting the Controller to the Robot Controller via 

DeviceNet using the "procedures for using configuration files". 

This document explains the procedures for setting up the Controller and the Robot Controller 

from the factory default setting. For the initialization, refer to Section 8 Initialization Method.  

 

■Setting Overview 

The following shows the relationship of processes to perform DeviceNet remote I/O 

communications using the "procedures for using configuration files". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Precautions for Correct Use  

Prepare the latest "Sysmac Studio project file" and "CX-Integrator project file" from OMRON 

in advance. 

(To obtain the files, contact your OMRON representative.) 

 

Configuration file 

Importing 
project file 

Sysmac Studio project file CX-Integrator project file 

Opening 
project file 

Transferring 
project data 

Installing  
EDS file Transferring 

scan list 

EDS file 

Sysmac Studio 
CX-Integrator 
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7.1. Work Flow 

Take the following steps to perform DeviceNet remote I/O communications.  

 

7.2. Wiring the network Wire the DeviceNet cable. 

↓  

 7.2.1 Hardware Settings for the 
DeviceNet Unit 

Set the hardware switches on the DeviceNet Unit 
and wire the network.  

↓  

7.3. Setting Up the ABB Robot 

Controller 

Set up the ABB Robot Controller.  

↓  

 7.3.1. DeviceNet Parameter Settings Set the DeviceNet parameters for the Robot 
Controller.  

↓  

 7.3.2. DeviceNet I/O Settings Make DeviceNet I/O settings for the Robot 
Controller.  

↓  

7.4. Setting Up the Controller Set up the Controller.  

↓  

 7.4.1. Starting the Sysmac Studio and 
Importing the Project File 

Start the Sysmac Studio and import the Sysmac 
Studio project file.  

↓  

 7.4.2. Connecting Online and 
Transferring the Project Data 

Connect online with the Sysmac Studio and transfer 
the project data to the Controller.  

↓  

7.5. Setting Up the Network Set up DeviceNet remote I/O communications.  

↓  

 7.5.1. Starting the CX-Integrator and 

Installing the EDS File 

Start the CX-Integrator and install the EDS file.  

↓  

 7.5.2. Opening the Project File Open the CX-Integrator project file. 

↓  

 7.5.3. Connecting Online and 
Transferring the Scan List 

Connect online with the Controller, and transfer the 
device setting (scan list) to the DeviceNet Unit via 
the Controller. 

↓  

7.6. Checking the DeviceNet 

Communications 

Confirm that the DeviceNet communications are 
performed normally.  

↓  

 7.6.1 Checking the Connection Status Check the connection status of DeviceNet.  

↓  

 7.6.2 Checking the Data that are Sent 
and Received 

Confirm that correct data are sent and received.  
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7.2. Wiring the network 

Wire the DeviceNet cable. 

 

7.2.1. Hardware Settings for the DeviceNet Unit 
Set the hardware switches on the DeviceNet Unit and wire the network.  

 

Precautions for Correct Use  

Make sure that the power supply is OFF when you perform the setting up.  

 

1 Make sure that the power supply 

to the Controller is OFF. 

 

*If the power supply is turned 

ON, settings may not be 

applicable as described in the 

following procedure.  

 

 

2 Check the hardware switches 

located on the front panel of the 

DeviceNet Unit by referring to 

the right figure.  

3 Set the Unit No. Switch to 0.  

 

Setting method: One-digit hexadecimal 

Setting range:0 to F 

Note:The unit number is set to 0 at the factory. 

4 Set the node address switches 

to 63.   
Setting method:Two-digit decimal 

Setting range:0 to 63 

Note:The node address is set to 63 at the factory. 
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5 Set only pin 2 of the DIP switch 

to ON. (Set pins 1, 3 and 4 of the 

DIP switch to OFF.) 

 

*Set the baud rate to 500 kbps. 

 

All pins are set to OFF at the factory. 

6 Connect the DeviceNet Unit to 

the CPU Unit. 

Connect the Controller with the 

DeviceNet cables and USB 

cable as shown in 5.2. Device 

Configuration. 

Connect the communications 

power supply to DeviceNet. 

 

 

 

DeviceNet cable 

T-branch Tap 

Controller 

USB cable Communications 
power supply 

DeviceNet Unit CPU Unit

End Cover 

Power Supply Unit 
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7.3. Setting Up the ABB Robot Controller 

Set up the ABB Robot Controller.  

 

 

Always confirm safety before you reset the Controller or any components.  

 

Precautions for Correct Use  

This document explains the setting procedure when the DeviceNet board is installed on the 

Robot Controller and safety circuits are connected.  

For information on installing the Robot Controller, refer to 2 Installation and Commissioning of 

the Product Manual Robot Controller IRC5 (3HAC021313-001).  

For information on installing the DeviceNet board, refer to 2. Hardware description of the 

Application Manual DeviceNet (HAC020676-001). 

 

7.3.1. Hardware Settings 
Set the DeviceNet parameters for the Robot Controller.  

 

1 Connect the Manipulator and 

FlexPendant to the Robot 

Controller. 

Connect the power supply cable 

and the DeviceNet cables. 

Turn ON the communications 

power supply to DeviceNet and 

the power supply to the Robot 

Controller. 

*For information on wiring the Robot Controller, refer to 2.5 

Connections of the Product Manual Robot Controller IRC5 

(3HAC021313-001).  

*For DeviceNet connection, refer to 2.2 Connections of the 

Application Manual DeviceNet (HAC020676-001).  

 

2 The initial window is displayed 

on the FlexPendant.  

Press ABB.  
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3 Press Control Panel.  

 

*If the window on the right is 

displayed in English, steps 4 to 

6 are unnecessary. Proceed to 

step 7.  

 

 

4 Press Language.  

 

5 Select English and press OK. 

 

6 A change confirmation window is 

displayed. Press the Yes Button. 

The Robot Controller restarts.  

The same initial window as step 

2 is displayed. Press ABB.  
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7 The window is displayed in 

English.  

Press Control Panel.  

8 Press Configuration.  

9 Select Bus and press Show All. 
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10 Select DeviceNet1 and press 

Edit.  

11 Display the next page by 

pressing .  

12 Select DeviceNet Master 

Address and press the value.  
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13 Enter 0 and press OK.  

14 Confirm that DeviceNet Master 

Address was changed to 0.  

Confirm that DeviceNet 

Communication Speed is 500 

kbps and press OK.  

 

 

 

 

 

 

 

 

*If a different value is set as the 

DeviceNet Communication 

Speed, select DeviceNet 

Communication Speed and 

press the value as shown on 

the right. Select 500 kbps from 

the pull-down list that is 

displayed.  
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15 If the setting values were 

changed in steps 12 to 14, the 

Restart Window is displayed. 

Press the No Button.  

If no change was made, proceed 

to step 16.  

16 Press Back. 

17 Select Unit and press Show All. 
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18 Press Add.  

19 Select Type of Unit and press 

the value.  

20 Select DN_SLAVE and press 

OK.  
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21 Select Connected to Bus and 

press the value.  

22 Select DeviceNet1 from the 

pull-down list.  

23 Display the next page by 

pressing .  
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24 Select DeviceNet Address and 

press the value.  

25 Enter 0 and press OK.  

26 Confirm that DeviceNet Address 

is 0.  

Press OK.  
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27 A restart confirmation window is 

displayed. Press the Yes Button. 
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7.3.2. DeviceNet I/O Settings 
Make DeviceNet I/O settings for the Robot Controller.  

 

1 The Robot Controller restarts 

and the initial window is 

displayed on FlexPendant.  

Press ABB.  

2 Press Control Panel.  

3 Press Configuration.  
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4 Select Signal and press Show 

All.  

5 Press Add.  

6 Select Name and press the 

value.  
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7 Enter di1 and press OK.  

8 Select Type of Signal, press the 

value, and then select Digital 

Input from the pull-down list that 

is displayed.  

9 Select Assigned of Unit, press 

the value, and then select tmp0 

from the pull-down list that is 

displayed.  
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10 Select Unit Mapping and press 

the value.  

11 Enter 0 and press OK.  

12 Press OK.  
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13 Press No. 

 

The same initial window as step 

5 is displayed.  

14 Add the following signals in the 
same way as steps 5 to 13.  
•Name: di2 
Type of signal: Digital Input 
Assigned to Unit: tmp0 
Unit Mapping: 1 

•Name: di3 
Type of signal: Digital Input 
Assigned to Unit: tmp0 
Unit Mapping: 2 

•Name: di4 
Type of signal: Digital Input 
Assigned to Unit: tmp0 
Unit Mapping: 3 

 

 

15 Add the following signals in the 
same way as steps 5 to 13.  
•Name: do1 
Type of signal: Digital Output 
Assigned to Unit: tmp0Unit 
Mapping: 0 

•Name: do2 
Type of signal: Digital Output 
Assigned to Unit: tmp0 
Unit Mapping: 1 

•Name: do3 
Type of signal: Digital Output 
Assigned to Unit: tmp0 
Unit Mapping: 2 

•Name: do4 
Type of signal: Digital Output 
Assigned to Unit: tmp0 
Unit Mapping: 3 

 

*Press the Yes Button in step 13 only when you make the 

last setting (setting for do4).  

16 The Robot Controller restarts 
and the initial window is 
displayed on FlexPendant.  
Press ABB.  

(The same window as step 2 is displayed.) 
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7.4. Setting Up the Controller 

Set up the Controller.  

 

7.4.1. Starting the Sysmac Studio and Importing the Project File 
Start the Sysmac Studio and import the Sysmac Studio project file.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Turn ON the power supply to the 

Controller. 

 

2 Start the Sysmac Studio.  

Click the Import Button.  

 

*If a confirmation dialog for an 

access right is displayed at 

start, select to start.  

 

3 The Import File Dialog Box is 

displayed. Select 

ABB_IRC5_DN_EV100.smc 

(Sysmac Studio project file) and 

click the Open Button. 

 

*Obtain the Sysmac Studio 

project file from OMRON.  
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4 The ABB_IRC5_DN_EV100 

project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

*If an error message is 

displayed stating "Failed to 

Load Descendants", change 

the version of the Sysmac 

Studio to the version specified 

in 5.2. Device Configuration or 

higher version.  

 

5 Double-click CPU/Expansion 

Racks under Configurations 

and Setup in the Multiview 

Explorer, and select the 

DeviceNet Unit that is displayed.

Confirm that CJ1W-DRM21 is 

displayed as shown on the right 

and that the unit number is 0. 

 

6 Select Check All Programs 

from the Project Menu.  

 

7 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

8 Select Rebuild Controller from 

the Project Menu.  

 

9 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 

10 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  

 

Multiview 
Explorer 

Edit Pane Toolbox 
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7.4.2. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

Always confirm safety before you reset the Controller or any components.  

 

 

1 Select Change Device from the 

Controller Menu.  

 

2 The Change Device Dialog Box 

is displayed.  

Confirm that Device and Version 

to use are set as shown on the 

right.  

*If the settings are not correct, 

select the setting items from 

the pull-down list.  

 

Click the OK Button.  
 

3 If the settings were changed in 

step 2, the Build Dialog Box is 

displayed. Check the contents 

and click the Yes Button. 
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4 Select Communications Setup 
from the Controller Menu.  

 

5 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option for Connection 

Type.  

 

Click the OK Button.  

6 Select Online from the 

Controller Menu.  

 

 

 

*If the dialog on the right is 

displayed, the model or version 

of the Controller does not 

match that of the project file. 

Match the Controller model and 

version by changing the device 

settings of the project file, and 

then repeat the procedure from 

step 1 in this section. Close the 

dialog box by clicking the OK 

Button. 

 

*The model and version 

displayed on the confirmation 

dialog box differ depending on 

the Controller used and the 

device setting of the project file. 

 

 
 
*Example of confirmation dialog 
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Additional Information  
For details on online connections to a Controller, refer to Section 5 Online Connections to a 

Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

7 A confirmation dialog box is 

displayed as shown on the right. 

Confirm that there is no problem 

and click the Yes Button. 

 

 

*The displayed dialog depends 

on the status of the Controller 

used. Click the Yes Button to 

proceed with the processing.  

 

*The displayed serial ID differs 

depending on the device.  

 

 

8 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  

 

 

9 Select Synchronization from 

the Controller Menu.  
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10 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right dialog) is 

selected. Then, click the 

Transfer to Controller Button. 

 

*After executing the Transfer to 

Controller, the Sysmac Studio 

data is transferred to the 

Controller and the data are 

compared.  

 

 

11 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 

 

 

A screen stating "Synchronizing" 

is displayed.  

 

 

A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 
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12 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized", 

and that a message is displayed 

stating "The synchronization 

process successfully finished". 

If there is no problem, click the 

Close Button.  

 

*A message stating "The 

synchronization process 

successfully finished" is 

displayed if the Sysmac Studio 

project data and the data in the 

Controller match.  

 

*If the synchronization fails, 

check the wiring and repeat 

from step 1.  

 

 

13 Select Mode - PROGRAM 

Mode from the Controller Menu.

 

 

 

 

A confirmation dialog box is 

displayed as shown on the right. 

Confirm that there is no problem 

and click the Yes Button. 

 

The Controller Status changed 

to PROGRAM mode. 
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14 Select Reset Controller from 

the Controller Menu. 

 

15 A confirmation dialog box is 

displayed. Click the Yes Button.

 

16 The Controller is reset and 

Sysmac Studio goes offline. 

The yellow bar on the top of the 

Edit Pane disappears.  

Go online by following steps 6 to 

8. 

Change to PROGRAM mode in 

the same way as step 13. 
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7.5. Setting Up the Network 

Set up DeviceNet remote I/O communications.  

 

7.5.1. Starting the CX-Integrator and Installing the EDS File 
Start the CX-Integrator and install the EDS file.  

 

1 Start the CX-Integrator. 

 

*If the Component List Window 

is not displayed, select 

Windows - Component List 

Window from the View Menu. 

 

2 Install the EDS file to register the 

Robot Controller in the network. 

 

Select EDS file - Install from 

the Tools Menu.  

Network Configuration

Window 

Output window 

Component List Window 
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3 Select [IRC5_Slave.eds] as an 

EDS file to install and click the 

Open Button.  

 

*For how to obtain the EDS file, 

refer to Precautions for Correct 

Use in 5.2. Device 

Configuration.  

 

4 The dialog box on the right is 

displayed. Check the contents 

and click the No Button.  

5 Select the EDS(DeviceNet) Tab 

on the Component List Window 

and confirm that the installed 

device was added ([Woodhead 

SST-DN3 Scanner] was added 

in the right figure).  

 

*When you install the 

[IRC5_Slave.eds], [Woodhead 

SST-DN3 Scanner] device will 

register. 
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7.5.2. Opening the Project File 
Open the CX-Integrator project file. 

 

1 Select Open from the File Menu. 

 

2 The Open Dialog Box is 

displayed. Select 

[ABB_IRC5_DN_EV100.cin] 

(CX-Integrator project file) and 

click the Open Button. 

3 The following devices are 

displayed in the Network 

Configuration Pane as shown in 

the right figure. 

#63: CJ1W-DRM21 

#00: Woodhead SST-DN3 

Scanner 

 

*IRC5 is shown as [Woodhead 

SST-DN3 Scanner]. 
 

 

 

 

Precautions for Correct Use  

Confirm that the DeviceNet cable is connected before proceeding to the following procedure. 

If it is not connected, turn OFF the power supply to each device, and then connect the 

DeviceNet cable.  
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7.5.3. Connecting Online and Transferring the Scan List 
Connect online with the Controller, and transfer the device setting (scan list) to the 

DeviceNet Unit via the Controller. When the transfer is completed, remote I/O 

communications start automatically. 

 

1 Select Auto Online from the 

Network Menu.  

 

2 The Auto Online Dialog Box is 

displayed. Select the USB 

connection Option for 

Connection type, and click the 

Connect Button.  

3 After an online connection is 

established, the background 

color of the Network 

Configuration Window changes 

as shown in the right figure.  

 

*IRC5 is shown as [Woodhead 

SST-DN3 Scanner]. 
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Additional Information  
If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 1, check the settings and repeat each step.  

Refer to Section 2 Basic Operations of the CX-Integrator Ver.2. Operation Manual (Cat. No. 

W464) for details.  

 

4 Right-click DeviceNet in the 

Online Connection Information 

Window, and select Connect.  

5 Select DeviceNet in the Select 

Network Dialog Box, and click 

the OK Button.  

6 Confirm that DeviceNet is in 

online status (  icon) in the 
Online Connection Information 
Window.  

 

7 Right-click CJ1W-DRM21 on the 

Network Configuration Window, 

and select Parameter - Edit.  



7. DeviceNet Connection Procedure 

 41

8 The Edit Device Parameters 

Dialog Box is displayed. Click 

the Download Button.  

9 A download confirmation dialog 

box is displayed. Confirm that 

there is no problem and click the 

Yes Button.  

 

A dialog box indicating the 

downloading is in progress is 

displayed.  
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10 The Edit Device Parameters 

Dialog Box is displayed again. 

Click the Compare Button.  

11 A dialog box shown on the right 

is displayed. Confirm that there 

is no problem. Click the Yes 

Button to compare the 

parameters.  

 

 

 

 

 

 

When the comparison is 

completed, a dialog box shown 

on the right is displayed. Check 

the contents and click the OK 

Button.  

 

 

 

 

The Edit Device Parameters 

Dialog Box is displayed again. 

Click the OK Button to close the 

dialog box.  
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7.6. Checking DeviceNet Communications 

Confirm that the DeviceNet communications are performed normally.  

 

7.6.1. Checking the Connection Status 
Check the connection status of DeviceNet.  

 

1 Confirm that the DeviceNet 

communications are performed 

normally by checking the LED 

indicators on each unit.  

 

•Controller (DeviceNet Unit) 

LED indicators in normal status: 

[MS]: Lit green 

[NS]: Lit green 

The 7-segment display shows 63 

during normal operation. (63: 

Master node address, remote I/O 

communications active and 

normal) 

 

 

(DeviceNet Unit) 

2 Confirm that the DeviceNet 

communications are performed 

normally from the CX-Integrator by 

referring to the status information on 

the Monitor Device Dialog Box.  

 

Right-click the DeviceNet Unit icon 

on the Network Configuration 

Window, and select Monitor.  
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3 The figure on the right shows the 

Status Tab Page of the Monitor 

Device Dialog Box.  

 

The DeviceNet communications are 

normally performed if the same 

items are selected in the Master 

Status Field, #00 is lit blue in the 

Slave Status Field, and the Remote 

I/O Communications Running 

Check Box is selected.  

 

Click the Close Button.  

（Monitor Device window） 

4 Go offline with the CX-Integrator.  

Select Work Online from the 

Network Menu.  

 

*The icon  is not pressed down 
during offline connection.  
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7.6.2. Checking the Data that are Sent and Received 
Confirm that correct data are sent and received.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch1 Tab Page is displayed 

in the lower section of the Edit 

Pane.  

3 The following names are entered in 

the Watch (Controller) Tab Page for 

monitoring. 

DN00_InputData_OUT[0-3] 

DN00_OutputData_IN[0-3] 

 

Click  on the left of the Name 

Column. The details are displayed. 

 
 

4 Click TRUE in the Modify Column of 

DN00_InputData_OUT[0]. 

 

 

 

 

 

The online value changes to True. 
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5 In the same way, click TRUE in the 

Modify Column of 

DN00_InputData_OUT[2]. 

6 Confirm that the window shown on 

the right is displayed on 

FlexPendant.  

If not displayed, press ABB.  

Press Inputs and Outputs. 

7 The Inputs and Outputs Window is 

displayed. 

Press View and select Digital 

Inputs. 
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8 The Digital Input Window is 

displayed. 

Confirm that 1 was set for the bit 

that was changed to 1 in step 4 and 

5.  

9 Press View and select Digital 

Outputs. 

10 The Digital Output Window is 

displayed.  

Select do2 and press 1.  
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11 The value of do2 is changed to 1.  

12 In the same way, set the value of 

do4 to 1.  

 

13 Return to the Sysmac Studio. 

Check the details of 

DN00_OutputData_IN[0-3] by 

clicking . 

The online values of 

DN00_OutputData_IN[1] and 

DN00_OutputData_IN[3] changed 

to True. 
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8. Initialization Method 
 

This document explains the setting procedure from the factory default setting. 

Some settings may not be applicable as described in this document unless you use the 

devices with the factory default setting. 

 

8.1. Initializing the Controller 

To initialize the settings of the Controller, it is necessary to initialize the CPU Unit and 

DeviceNet Unit. Place in PROGRAM mode before the initialization. 

 

8.1.1. DeviceNet Unit 
To initialize the settings of the DeviceNet Unit, select Edit Special Unit Settings of 

CJ1W-DRM21 in CPU/Expansion Racks from the Sysmac Studio.  

Select Clears the scan list for Scan List Clear Switch. 

 
 

Click the Apply Button and click the Transfer to Controller Button. 
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8.1.2. CPU Unit 
To initialize the settings of the Controller, select Clear All Memory from the Controller 

Menu of the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Click the OK 

Button.  
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8.2. Initializing the ABB Robot Controller 

To initialize the ABB Robot Controller, execute Restart - I-Start by using the following 

procedure.  

 

1 Press Restart.  

2 Press Advanced.  

 

The Advanced Restart window 

is displayed.  
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3 Select I-Start and click OK.  

4 Press I-Start.  

5 The initial window is displayed 

again.  
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9. Appendix 1 Details of Remote I/O Communications 

Settings 
 

This section explains the details on the settings necessary to perform DeviceNet remote I/O 

communications. 

 

9.1. Global Variable Table 

The Controller accesses the remote I/O communications data as global variables. The 

following are the settings of the global variables. Register a global variable table with the 

Sysmac Studio. 

 

Name Data type AT Destination device allocation 
DN00_InputData_OUT BOOL[64] %3200 to %3203 Digital Input 00 to 63 (8 bytes)

DN00_OutputData_IN 
BOOL[64] 

%3300 to %3303
Digital Output 00 to 63  
(8 bytes) 

 
In this document, only the following areas are allocated. 

■Details on output area 

63 to 04 03 02 01 00
DN00_InputData_OUT[64] 

Not used di4 di3 di2 di1

 

■Details on input area 

63 to 04 03 02 01 00
DN00_OutputData_IN[64] 

Not used do4 do3 do2 do1

 

Additional Information  
You can assign the same address to more than one variable. However, this is not 

recommended as it reduces readability and makes the program more difficult to debug. If you 

do this, set an initial value for only one of the variables. If you set a different initial value for 

each individual variable, the initial value is not stable.  

 

Additional Information  
With the Sysmac Studio, two methods can be used to specify an array for a data type. After 

specifying, (1) is converted to (2) and the data type is always displayed as (2).  

(1)WORD[3] / (2) ARRAY[0..2] OF WORD 

In this document, the data type is simplified by displaying WORD[3].  

(The example above means a WORD data type with three array elements.) 
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Personal computer 

Destination 

device 

Controller 

 

10. Appendix 2 Setting Procedure without the 

Configuration Files 
 

This section describes the procedure for setting the Controller without the configuration files 

(Procedure for setting parameters from the beginning).  

You can also refer to this section when you want to change the parameters of the 

configuration files.  

 

10.1. Overview of Setting Procedure without the Configuration Files 

The following is the relationship of processes to perform remote I/O communications using the 

"procedure for setting parameters from the beginning". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings made with Sysmac Studio 
•Setting parameters (DeviceNet Unit) 
•Setting global variables (names and 
AT, etc) 

•Building 
•Settings in the Watch Tab Page 

Settings made with CX-Integrator 
•Creating network configuration 
•Setting device (creating scan list)

Transferring 
project data 

Installing  
EDS file Transferring 

scan list 

EDS file 

CX-Integrator Sysmac Studio 
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10.2. Work Flow of "Procedure for Setting Parameters from the Beginning" 

Take the following steps to make the connection settings for DeviceNet remote I/O 

communications using the "procedure for setting parameters from the beginning". 

This section describes the detailed procedures for 10.3 Setting the Controller without the 

Configuration Files and 10.4 Setting Up the Network Using CX-Integrator (in red frames 

below) without using the "configuration files". 

The procedures for 7.2.Wiring the network, 7.3. Setting Up the ABB Robot Controller, and 7.5. 

Checking DeviceNet Communications are the same as the "procedure for using the 

configuration files". Refer to the procedures in Section 7.  

 

7.2. Wiring the network Wire the DeviceNet cable. 

↓  

 7.2.1 Hardware Settings for the 
DeviceNet Unit 

Set the hardware switches on the DeviceNet Unit 
and wire the network.  

↓  

7.3. Setting Up the ABB Robot 

Controller 

Set up the ABB Robot Controller.  

↓  

 7.3.1. DeviceNet Parameter Settings Set the DeviceNet parameters for the Robot 
Controller.  

↓  

 7.3.2. DeviceNet I/O Settings Make DeviceNet I/O settings for the Robot 
Controller.  

↓  
10.3. Setting Up the Controller without 

the Configuration Files 
Set up the Controller using the software.  

↓  
 10.3.1. Starting the Sysmac Studio and 

Setting the Parameters for the 
Controller 

Start the Sysmac Studio and set the parameters for 
the Controller.  

↓  
 10.3.2. Setting the Global Variables Set the global variables to use for remote I/O 

communications. 
↓  

 10.3.3. Connecting Online and 
Transferring the Project Data 

Connect online with the Sysmac Studio and transfer 
the project data to the Controller.  

↓  
 10.3.4. Settings in the Watch Tab Page Make settings in the Watch Tab Page to check data 

that is sent and received. 
↓  
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10.4. Setting Up the Network Using 
CX-Integrator 

Set up DeviceNet remote I/O communications.  

↓  
 10.4.1. Starting the CX-Integrator and 

Installing the EDS File 
Start the CX-Integrator and install the EDS file.  

↓  
 10.4.2. Creating the Network 

Configuration 
Create the network and device configuration offline. 

↓  
 10.4.3. Setting the Device Set the device and register it in the DeviceNet Unit 

(create a scan list).  
↓  

 10.4.4. Connecting Online and 
Transferring the Scan List 

Connect online with the Controller, and transfer the 
device setting (scan list) to the DeviceNet Unit via 
the Controller. 

↓  
7.6. Checking the DeviceNet 

Communications 
Confirm that the DeviceNet communications are 
performed normally.  

↓  
 7.6.1 Checking the Connection Status Check the connection status of DeviceNet.  

↓  
 7.6.2 Checking the Data that are Sent 

and Received 
Confirm that correct data are sent and received.  
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10.3. Setting Up the Controller without the Configuration Files 

Set up the Controller using the software.  

 

10.3.1. Starting the Sysmac Studio and Setting the Parameters for the 
Controller 

Start the Sysmac Studio and set the parameters for the Controller.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Turn ON the power supply to the 

Controller. 

 

2 Start the Sysmac Studio.  

Click the New Project Button.  

 

*If a confirmation dialog for an 

access right is displayed at 

start, select to start.  

 

3 The Project Properties Dialog 
Box is displayed.  
 
*In this document, New Project 
is set as the project name.  

 
Confirm that Category and 
Device to use are set in the 
Select Device Field. 
  
Select version 1.05 from the 
pull-down list of Version. 
*Although 1.05 is selected in this 
document, select the version 
you actually use. 
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4 Click the Create Button.  

5 The New Project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

6 Double-click CPU/Expansion 

Racks under Configurations 

and Setup in the Multiview 

Explorer. 

The CPU/Expansion Racks Tab 

is displayed in the Edit Pane. 

 

Multiview 
Explorer 

Edit Pane Toolbox 
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7 Select Communications under 

Category in the Toolbox. 

 

Select CJ1W-DRM21 Ver.1.1. 

 

 

Right-click on CJ1W-DRM21 

Ver.1.1. 

Select Insert from the menu that 

is displayed. 

 

CJ1W-DRM21 is displayed on 

the CPU/Expansion Racks Tab 

Page as shown on the right. 

      
 

8 Enter 0 for Unit No. 
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10.3.2. Setting the Global Variables 
Set the global variable to use for remote I/O communications. 

 

1 Double-click Global Variables 

under Programming - Data in 

the Multiview Explorer.  

 

2 The Global Variables Tab Page 

is displayed in the Edit Pane.  

Click a column under the Name 

Column to enter a new variable. 

 

Enter DN00_InputData_OUT in 

the Name Column. 

 

Enter BOOL[64] in the Data 

Type Column. 

*After entering, the value 

changes to ARRAY[0..63] OF 

BOOL as shown on the right. 

 

Enter %3200 in the AT Column. 

 

 

 

 

3 After entering, right-click and 

select Create New from the 

menu.  

 

4 Enter the following data in the 
new columns in the same way 
as step 2.  
•Name: DN00_OutputData_IN. 
Data type: BOOL[64] 
AT: %3300 
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10.3.3. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller. After 

transferring, reset the Controller. 

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

Always confirm safety before you reset the Controller or any components.  

 

 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

3 Select Rebuild Controller from 
the Project Menu.  

 

4 A confirmation dialog box is 

displayed. Check the contents 

and click the Yes Button. 

5 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  
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6 Select Communications Setup 

from the Controller Menu.  

 

7 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option for Connection 

Type.  

 

Click the OK Button.  

8 Select Online from the 

Controller Menu.  

A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 

 

*The displayed dialog depends 

on the status of the Controller 

used. Check the contents and 

click the Yes Button to proceed 

with the processing. 

 

 
 

9 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  

 

Additional Information  
For details on online connections to a Controller, refer to Section 5 Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 



10. Appendix 2 Setting Procedure without the Configuration Files 

 63

10 Select Synchronization from 

the Controller Menu.  

 

11 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right dialog) is 

selected. Then, click the 

Transfer to Controller Button. 

 

*After executing the Transfer to 

Controller, the Sysmac Studio 

data is transferred to the 

Controller and the data are 

compared.  

 

 

12 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 

 

 

A screen stating "Synchronizing" 

is displayed.  

 

 

The dialog box on the right is 

displayed. Confirm that there is 

no problem and click the Yes 

Button. 
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13 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized",  

and that a message is displayed 

stating "The synchronization 

process successfully finished". 

If there is no problem, click the 

Close Button.  

 

*A message stating "The 

synchronization process 

successfully finished" is 

displayed if the Sysmac Studio 

project data and the data in the 

Controller match.  

 

*If the synchronization fails, 

check the wiring and repeat 

from step 1.  

 

 

14 Select Mode - PROGRAM 

Mode from the Controller Menu.

 

 

 

 

 

A confirmation dialog box on the 

right is displayed. Confirm that 

there is no problem and click the 

Yes Button. 

 

The Controller Status changed 

to PROGRAM mode. 
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15 Select Reset Controller from 

the Controller Menu. 

 

16 A confirmation dialog box is 

displayed. Check the contents 

and click the Yes Button. 

 

16 The Controller is reset and the 

Sysmac Studio goes offline. 

The yellow bar on the top of the 

Edit Pane disappears.  

Go online by following steps 6 to 

8. 

Change to PROGRAM mode in 

the same way as step 13. 
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10.3.4. Settings in the Watch Tab Page 
Make settings in the Watch Tab Page to check data that is sent and received. 

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch1 Tab Page is displayed 

in the lower section of the Edit 

Pane.  

3 Enter the following names in the 
Watch1 Tab Page for monitoring. To 
enter a new name, click a column 
stating Input Name.  

DN00_InputData_OUT[0-3] 
DN00_OutputData_IN[0-3] 

 
 
*You will use the settings in 7.6.2. 
Checking the Data That are Sent 
and Received. 
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10.4. Setting Up the Network Using the Software 

Set up DeviceNet remote I/O communications by using the software. 

 

10.4.1. Starting the CX-Integrator and Installing the EDS File 
Start the CX-Integrator and install the EDS file.  

 

1 Start the CX-Integrator. 

 

*If the Component List Window 

is not displayed, select 

Windows - Component List 

Window from the View Menu. 

 

2 Install the EDS file to register the 

Robot Controller in the network. 

 

Select EDS file - Install from 

the Tools Menu.  

Network Configuration

Windows 

Output window 

Component List Window 
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3 Select [IRC5_Slave.eds] as an 

EDS file to install and click the 

Open Button.  

 

*For how to obtain the EDS file, 

refer to Precautions for Correct 

Use in 5.2. Device 

Configuration.  

 

4 The dialog box on the right is 

displayed. Check the contents 

and click the No Button.  

5 Select the EDS(DeviceNet) Tab 

on the Component List Window 

and confirm that the installed 

device was added ([Woodhead 

SST-DN3 Scanner] was added 

in the right figure).  

 

*When you install the 

[IRC5_Slave.eds], [Woodhead 

SST-DN3 Scanner] device will 

register. 
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10.4.2. Creating the Network Configuration 
Create the network and device configuration offline.  

 

1 Select Network from the Insert 

Menu of the CX-Integrator.  

 

2 Select DeviceNet and click the 

Next Button.  

3 Select the Not Used Check Box 

for Network Address and click 

the Finish Button.  

4 Register the DeviceNet Unit in 

the Network.  

Select Component from the 

Insert Menu.  
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5 Select the DeviceNet Unit from 

the component list and click the 

Finish Button.  

OMRON Corporation - 

Communications Adapter - 

CJ1W-DRM21 is selected here. 

6 Enter the node address (63 is 

entered here) in the Node 

Address Setup Dialog Box, and 

click the OK Button.  

 

7 Confirm that the DeviceNet Unit 

is registered in the Network 

Configuration Window.  

 

8 Register the Robot Controller 

(hereinafter referred to as the 

Slave Unit) in the network.  

Select Component from the 

Insert Menu.  
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9 Select the Slave Unit to connect 

from the component list, and 

click the Finish Button.  

Woodhead SST-DN3 Scanner is 

selected here.  

 

*When you install the 

[IRC5_Slave.eds], [Woodhead 

SST-DN3 Scanner] device will 

register. 

 

10 Enter the node address (0 is 

entered here) in the Node 

Address Setup Dialog Box, and 

click the OK Button.  

 

11 Confirm that the Slave Unit is 

registered in the Network 

Configuration Window.  
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10.4.3. Setting the Device 
Set the device and register it in the DeviceNet Unit (create a scan list).  

 

1 Right-click the DeviceNet icon 

and select Parameter - Edit.  

2 The Edit Device Parameters 

Dialog Box is displayed.  

Slave Unit (#00) is displayed in 

the Unregister Device List.  

 

 

Select the Auto allocation as is 

registered Check Box.  

Click the ↓ button.  

 

 

 

 

Slave Unit (#00) is registered in 

the Register Device List.  

 

Confirm that the sizes and 

channels are set as follows, and 

click the OK Button.  

  OUT Size: 8 Byte 

  Out Ch: 3200:Bit00 

  In Size: 8 Byte 

  In Ch: 3300:Bit00 
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3 Confirm that node address #63 

is displayed under the slave unit 

icon on the Network 

Configuration Window.  

 

* The icon of IRC5 is the 

[Woodhead SST-DN3 Scanner] 

device.  

 

  

 

Precautions for Correct Use  

Confirm that the DeviceNet cable is connected before proceeding to the following procedure. 

If it is not connected, turn OFF the power supply to each device, and then connect the 

DeviceNet cable.  
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10.4.4. Connecting Online and Transferring the Scan List 
Connect online with the Controller, and transfer the device setting (scan list) to the 

DeviceNet Unit via the Controller. When the transfer is completed, remote I/O 

communications start automatically.  

 

1 Select Auto Online from the 

Network Menu.  

 

2 The Auto Online Dialog Box is 

displayed. Select the USB 

connection Option for 

Connection type, and click the 

Connect Button.  

 

A confirmation dialog is 

displayed indicating the 

connection is being established. 

3 After an online connection is 

established, the background 

color of the Network 

Configuration Window changes 

as shown in the right figure.  

 

* The icon of IRC5 is the 

[Woodhead SST-DN3 Scanner] 

device.  
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Additional Information  
If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 1, check the settings and repeat each step.  

Refer to Section 2 Basic Operations of the CX-Integrator Ver.2. Operation Manual (Cat. No. 

W464) for details.  

 

4 Right-click DeviceNet in the 

Online Connection Information 

Window, and select Connect.  

5 Select DeviceNet in the Select 

Network Dialog Box, and click 

the OK Button.  

6 Confirm that DeviceNet is in 

online status (  icon) in the 
Online Connection Information 
Window.  

 

7 Right-click CJ1W-DRM21 on the 

Network Configuration Window, 

and select Parameter - Edit.  
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8 The Edit Device Parameters 

Dialog Box is displayed. Click 

the Download Button.  

9 A download confirmation dialog 

box is displayed. Confirm that 

there is no problem and click the 

Yes Button.  

 

A dialog box indicating the 

downloading is in progress is 

displayed.  
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10 The Edit Device Parameters 

Dialog Box is displayed again. 

Click the Compare Button.  

11 A dialog box shown on the right 

is displayed. Confirm that there 

is no problem and click the Yes 

Button to compare the 

parameters.  

 

 

 

 

 

When the comparison is 

completed, a dialog box shown 

on the right is displayed. Check 

the contents and click the OK 

Button.  

 

 

 

 

 

The Edit Device Parameters 

Dialog Box is displayed again. 

Click the OK Button to close the 

dialog box.  
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